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Important Information

Warning

The data and examples in this manual cannot be copied without authorization. SST Automation reserves the right

to upgrade the product without notifying users.

The product has many applications. The users must make sure that all operations and results are in accordance

with the safety of relevant fields, and the safety includes laws, rules, codes and standards.

Copyright
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1 Product Overview
1.1 Function
GT200-DP-EI gateway is solution to connect EtherNet/IP and PROFIBUS DP network easily and quickly. This

gateway supports interconnection between PROFIBUS DP master PLC and AB (Rockwell) PLC.

1.2 Features
 With an Ethernet interface (EtherNet/IP slave interface) and a PROFIBUS DP slave interface.

 Ethernet 10/100M adaptive.

 IP address conflict detection.

 Support DHCP, BOOTP and static setting.

 I/O data monitoring capabilities.

1.3 Technical Specification
[1] Support PROFIBUS DP V0 protocol.

[2] PROFIBUS DP slave, baud rate adaptive, maximum baud rate 12M.

[3] PROFIBUS DP:

 Max input data bytes is 244 bytes.

 Max output data bytes is 244 bytes.

 input + output data bytes is 488 bytes.

[4] PROFIBUS DP interface: 1KV photoelectric isolation.

[5] Support ODVA standard EtherNet/IP communication protocol.

[6] EtherNet/IP can support 3 groups I/O communication simultaneously.

[7] I/O data accessing of EtherNet/IP can support 2 ways:

 Set up I/O connection to access I/O data directly (Recommended).

 Use MSG command to access I/O data (Advanced function).

[8] Two end network can monitor connection status mutually.

[9] Provide byte swap function: No swap, two bytes swap and four bytes swap.

[10] Power supply 24VDC (11~30VDC), 160mA (24VDC).

[11] Operating temperature: -4°F to 140°F (-20℃~60℃). Humidity: 5% ~ 95% (no condensation).

[12] External Dimensions (W*H*D): 1.6in*5.0in*4.4in (40mm* 125mm * 110mm).

[13] Installation: 1.4 in (35 mm) RAIL.

[14] Protection level: IP20.
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1.4 Related Products
Related products include:GT200-DP-CA, GT200-CO-EI, GT200-EI-2RS485, GT200-DP-EI etc.

To get more information about related products, please visit SSTCOMM website: www.sstautomation.com.

1.5 Revision History

Revision Date Chapter Description

V1.7 Rev A 1/13/2022 ALL Update the format

https://www.sstautomation.com
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2 Hardware Description

2.1 Product Appearance

Notes: This picture is for reference only. The product appearance is subject to the actual product.

Ethernet

PROFIBUS DP Interface

DIP Switch

Power Supply
Indicator

PROFIBUS DPAddress

Setting Switch
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2.2 Indicators

Indicators Status Description

STA(green)
Blink PROFIBUS DP bus data is communicating.

Off No data communicating.

PBF (red)
On PROFIBUS DP bus data communication fails.

Off Communication is ok.

MS

Blink (red) DHCP or BOOTP status.

On (red) IP confliction.

OFF(red) Normal communication.

NS

On(green) Modbus TCP connection has been established.

Flash(green) Modbus TCP connection is not established or disconnected.

OFF(green) Modbus TCP is not started.

MS, NS, and STA flashes once Boot up.

MS and NS ON Configuration status.

2.3 Switch

2.3.1 DIP Switch

The configuration switch is located on the button of the product. The function is listed below:

Mode(1) Function(2) Description

Off Off Run mode, allow reading and writing configuration data.

Off On Run mode, forbid reading and writing configuration data.

On Off

Configuration mode, IP address is 192.168.0.10 (fixed),

this mode can read and write configuration data but

cannot finish communication between EtherNet/IP and

PROFIBUS DP.

On On Reserved.

Notes: Restart GT200-DP-EI (power off and power on) after resetting the configuration to make the

configuration take effect!
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2.3.2 PROFIBUS DPAddress Setting Switch

The 2-code rotary switch in the left-side is used for setting the PROFIBUS DP address of the device.

In this example, the calculation formula of PROFIBUS DP address will be: 42 ((4x10) + (2x1)).

2.4 Interface

2.4.1 Power Interface

GND

NC

24V+

1

2

3

2.4.2 Ethernet Interface

Ethernet interface uses RJ-45 connector, 10/100M self-adaptive. its pin (standard Ethernet signal) is defined as

below:

pin Signal Descriptions

S1 TXD+, Transmit Data+

S2 TXD-, Transmit Data-

S3 RXD+, Receive Data+

S4 Bi-directional Data+

S5 Bi-directional Data-

S6 RXD-,Receive Data-

S7 Bi-directional Data+

S8 Bi-directional Data-

Pin Function
1 Power GND

2 NC，(Not Connected)

3 24V+, DC
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2.4.3 PROFIBUS DP Interface

Pin Function

3 PROFI_B, Data positive

5 GND

8 PROFI_A, Data negative

PROFI_A (Pin 8)

PROFI_B (Pin 3) GND (Pin5)
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3 Installation

3.1 Machine Dimension
Size (width * height * depth):

1.6 in * 5.0 in 4.4 in (40 mm * 125 mm * 110 mm)
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3.2 Installation Method
Using 1.4 in (35mm) DIN RAIL.

Install the gateway

Uninstall the gateway

1. Use a screwdriver to pass through the DIN RAIL bar, pull down and hold.

2. Pull out the gateway.

3. Lift up the gateway.
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4 Quick Start Guide
Basic steps when configuring GT200-DP-EI:

1. Wiring：See also Chaper2.4 Interface.

(1) Connect the network port of the gateway to the PC with a network cable for downloading the configuration.

(2) Connect the PROFIBUS DP port of the gateway to the PLC for communication.It is recommended to use

standard PROFIBUS DP connector to finish the wiring.

(3) Connect the gateway power supply and power on.

2. Download SST-EP-CFG software from www.sstcomm.com/Download1/ and install it.

3. Download GSD file and EDS file for GT200-DP-EI from www.sstcomm.com/Download1/.

4. Build your configuration using SST-EP-CFG and download it to the gateway. For more details,see SST-EP-

CFG software->Help->Contents.

(1) The software can configure the IP address of the gateway and EtherNet/IP protocol related parameters.

(2) Please set the PROFIBUS DP protocol related parameters in the configuration software of the PROFIBUS

DPMaster station.

(3) Please use the rotary switch on the gateway to set the PROFIBUS DP address. Also see Chapter 2.3.2.

If the gateway cannot be searched，please note:

 The network factory setting of GT200-DP-EI is 192.168.0.XXX. Please check whether the computer and

gateway are in the same network segment.

 Please test the network connection first. Please refer to the note “How to Use the Ping Command” located

on our Support page on the sstcomm.com website.

 If you are not sure about the IP address of the gateway. Please set the DIP switch to “1-ON, 2-OFF” ,

make the gateway enter the configuration mode, and restart GT200-DP-EI (power off and power on).

At this time, the IP address will be fixed to 192.168.0.11

5. Install the EDS file in the configuration software of the EtherNet/IP Master station. Configure the EtherNet/IP

network as required. Make sure that the configuration matches the configuration present in the GT200-DP-EI.

6. Install the GSD file in the PROFIBUS DP configuration tool. Configure the PROFIBUS DP network as

required. Make sure that the configuration matches the configuration present in the GT200-DP-EI.

https://www.sstcomm.com/Download1/
https://www.sstcomm.com/Download1/
https://www.sstcomm.com/Download1/
https://www.sstcomm.com/d/file/article/FAQ/How_to_Use_the_Ping_Command_EN_TN.pdf
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5 Configuration Software SST-EP-CFG

SST-EP-CFG is the software based on Windows platform. It is used to configure GT200-DP-EI through network

Interface. Download the software on www.sstcomm.com/Download1/ and run the setup program to begin the

installation. Please follow the prompts to install the software.

For detailed software content, please open the SST-EP-CFG, select “Help” >> “Contents” on the menu bar.

Double-click on the icon to device selecting interface:

Choose the GT200-DP-EI, and enter the main interface:

Equipment plate:

Users can choose operation

object, includes Ethernet type,

adding node and command

Menu Bar
Title Bar

Configuration plate:

Input configuration parameters,

gray parts cannot be modified

Comment plate:

Explain the function of the

configuration options

Toolbar

https://www.sstcomm.com/Download1/
app:ds:title
app:ds:bar
app:ds:comment%20field
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6 Working Principle

6.1 EtherNet/IP Connection Parameters
Connection parameters the gateway provides are as below:

 Input Instance: 102 (4+244 Bytes), 112 (4+244 Bytes), 122 (4+244 Bytes).

 Output Instance: 101 (244 Bytes), 111 (244 Bytes), 121 (244 Bytes).

 Configuration Instance: 113 (10 Bytes).

Input Instance 102, 112, 122 data length can be set in SST-EP-CFG, range 5~248 bytes, among them the first four

bytes are the real time frame header (Reserved).

Output Instance 101,111, 121 data length can be set in SST-EP-CFG, range 1~244 bytes.

Take configuration parameters of RSLogix5000 as an example:

Notes: The "Size" (the bytes number that has been configured) in the above picture, is consistent with the

input/output bytes number of Instance which has been configured in the configuration software SST-EP-CFG).



User Manual
EtherNet/IP / PROFIBUS DP Gateway
GT200-DP-EI

www.SSTAutomation.com 12

6.2 How to Read/Write I/O Data

6.2.1 Read and Write Data using I/O mode(Recommended)

The following RSLogix 5000 example will describe how to read/write I/O data using I/O mode.

Right click on EtherNet/IP master module, click "New Module", as shown below:

In the pop-up dialog box, unfold "+" before "Communications", choose "ETHERNET-MODULE", click "OK", as

shown below:
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Configure relevant information of GT200-DP-EI in the pop-up window, as shown below:

In the above picture, the module information needs to be configured includes:

Name: Name the added EtherNet/IP salve module (GT200-DP-EI module).

Comm Format: Configure data types. Users can choose data types as DINT, INT, SINT and REAL, etc. After

confirmation, this cannot be changed. If you want to change data types, you can create new module.

IP Address: Set IP address of the EtherNet/IP slave module (IP address of GT200-DP-EI). IP address of GT200-

Set name of EtherNet/IP

slave

IP address of GT200-DP-EI

Set Instance and size.

This means 248 bytes

input and 244 byte

output
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DP-EI is the address downloaded into module through software SST-EP-CFG.

Connection Parameters: Set Connection parameters during communication, this parameter GT200-DP-EI

supports can refer to past chapter.

Note: "Size" (configured bytes) in the above picture should be the consistent with relevant input and output

bytes of Instance in the SST-EP-CFG.

Click "OK", set master polling time interval in the pop-up dialog box, the default is 10ms, as shown below:

After setting this interval, click "OK" to save. Double click "Controller Tags", unfold "GT200DPEI: O", as shown

below:
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In the above picture, GT200DPEI:O.Data [0] ~GT100EIRS:O.Data [60] is the corresponding output data address

of GT200-DP-EI module in master.

Unfold "GT200DPEI: I", as shown below:

In the above picture, four bytes of GT200DPEI: I. Data [0] is real time frame head of EtherNet/IP slave.
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GT200DPEI:I.Data [1] ~GT100EIRS: I. Data [61] is the corresponding input data address of GT200-DP-EI

module in master.

6.2.2 Read and Write Data using MSG

The following RSLogix 5000 example will describe how to read/write I/O data using MSG.

1 Read I/O Data

Create a new project. it is in the "Offline" mode. Add two new tags "ReadTag" and "ReadData" under the

"Controller Tags" and set the type of "ReadTag" as "MESSAGE" and "ReadData" as "DINT [500]".

Right click "ReadTag", select "Configure "ReadTag"":
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In the new pop-up window, it needs to set some parameters as below:

Message Type: CIP Generic.

Service Type: Select "Get Attribute Single", now, relevant service code will become "e (Hex)".

Class: 4 (Hex).

Instance: 102 (4+244 Bytes), 112 (4+244 Bytes) and 122 (4+244 Bytes) can be set.

Attribute: 3 (Hex).

Destination: Select "ReadData" label, now, the data that have been received will be saved in this tag.
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Choose "Communication" label, input the relevant path of connecting EtherNet/IP slave in the blank space behind

the Path, the path format is: EthetNet IP hostname, EtherNet/IP master slot No., IP address of EtherNet/IP slave,

after setting the path, click "Apply", "Confirm". As is shown below:

In this instance, EtherNet/IP hostname is "Master", EtherNet/IP master slot No. Is "2", EtherNet/IP slave (GT200-

DP-EI) is "192.168.0.10". IP address of GT200-DP-EI is the address which is downloaded into the module

through SST-EP-CFG.
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Add a "MSG" command in "MainRoutine" under the "MainProgram" and choose "ReadTag" as "Message

Control", as shown below:

This is a simple command which can sent a read request, it still needs to add some logic commands to trigger this

command in common program. About the detailed information, please refer to RSLogix5000.

Download the program to the PLC and set PLC into "Online" state.

Click "Control Tags" and select "Monitor Tags", unfold "ReadData", shown as below. Data stored starting from

PLC read data command
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address ReadData[0] are the data PLC read from PROFIBUS DP master through gateway GT200-DP-EI.

2 Write I/O Data

Enter the "Offline" mode, add two new tags "WriteTag" and WriteData" under the "Controller Tags". Define the

type of "WriteTag" as "MESSAGE" and "WriteData" as "DINT [500]":
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Enter the "Monitor Tags" interface. input some data beginning from address WriteData[0] in the "WriteData" tag.

These data will be outputted to GT200-DP-EI through PLC for PROFIBUS DP reading.

Right click "WriteTag", select "Configure "WriteTag"":
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In the new pop-up window, it needs to configure as below:

Message Type: CIP Generic

Service Type: Select "Set Attribute Single", now, relevant Service Code will become "10 (Hex)"

Class: 4 (Hex)

Instance: 101 (244Bytes), 111 (244Bytes) and 121 (244Bytes) optional

Attribute: 3 (Hex)

Source Element: Select "WriteData" tag, it indicates the data in the "WriteData" tag will become the data PLC

outputs.

Source Length: Use byte as unit, this value should be less than or equal to the current selecting bytes which

Instance represents (Configured bytes number in SST-EP-CFG).

Choose "Communication" label, input the relevant path of connecting EtherNet/IP slave in the blank space behind

the Path, the path format is: EthetNet IP hostname, EtherNet/IP master slot No., IP address of EtherNet/IP slave,

after setting the path, click "Apply", "Confirm". As is shown below:
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In this instance, EtherNet/IP hostname is "Master", EtherNet/IP master slot No. Is "2", EtherNet/IP slave (GT200-

DP-EI) is "192.168.0.10". IP address of GT200-DP-EI is the address which is downloaded into the module

through SST-EP-CFG.

Add a "MSG" command in "MainRoutine" under the "MainProgram" and choose "WriteTag" as "Message

Control", as shown below:

Download PLC program to the PLC and set PLC to "Online" state, the data in "WriteData" will be outputted to

PROFIBUS DP master through GT200-DP-EI (EtherNet/IP slave).

PLC read-data command

PLC write-data command
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6.3 Step7 Read and Write Gateway Data
GT200-DP-EI provides Modules shown as follow. The maximum allowed number of modules is 64 in Step7. The

maximum allowed number of input bytes is 244, the max number of output bytes is 244 and the aggregate of

maximum number of input bytes and output bytes is 488.

Module Consistent

4 Words Input, 4 Words Output Word Consistent

8 Words Input, 8 Words Output Word Consistent

24 Words Input, 24 Words Output Word Consistent

56 Words Input, 56 Words Output Word Consistent

1 Byte Input Byte Consistent

1 Word Input Word Consistent

2 Words Input Word Consistent

4 Words Input Word Consistent

8 Words Input Word Consistent

16 Words Input Word Consistent

32 Words Input Word Consistent

64 Words Input Word Consistent

2 Words Input Consistent length Consistent

4 Words Input Consistent length Consistent

8 Words Input Consistent length Consistent

16 Words Input Consistent length Consistent

1 Byte Output Byte Consistent

1 Word Output Word Consistent

2 Words Output Word Consistent

4 Words Output Word Consistent

8 Words Output Word Consistent

16 Words Output Word Consistent

32 Words Output Word Consistent

64 Words Output Word Consistent

2 Words Output Consistent Total length Consistent

4 Words Output Consistent Total length Consistent

8 Words Output Consistent Total length Consistent

16 Words Output Consistent Total length Consistent

As is shown above, the data modules which GT200-DP-EI supports include: Word Consistent, Byte Consistent
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and Length Consistent.

For the data modules that support Word and Byte Consistent, you can use command "MOVE" to access the data

during STEP7 programming.

For the data modules that support length Consistent, user can take compression way to send and receive data. The

compression way mainly uses "SFC 15" when sending and receiving uses "SFC 14":

SFC14 (compressing sending)

SFC15 (compressing receiving)

6.4 Network Status Monitoring
GT200-DP-EI can support both ends network monitoring each other. This function can be set to enable or disable.

If PROFIBUS side enables network status monitor function, the network status word occupies the first two bytes

of input data, and input data will move backward two bytes, the available max input data will become 242 bytes.

If it disables, then it doesn't occupy input data bytes.

If EtherNet/IP side enables network status monitor function, he network status word occupies the first two bytes

of input data, and input data will move backward two bytes after real time frame header, the available max input

data will become 242 bytes. If it disables, then it doesn't occupy input data bytes.

Network status word: it will be 0 when peer network has established connection. it will be 1 when peer network

hasn't established connections or connections have broken.
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7 Typical Application

In this typical application, GT200-DP-EI acts connects PROFIBUS DP and EtherNet/IP network. It realizes the

data exchange between PROFIBUS master PLC (or controller, IPC) and EtherNet/IP master PLC (or controller,

IPC).

GT200-DP-EI supports interconnection between Siemens PROFIBUS DP master PLC and AB (Rockwell) PLC.
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Appendix: Using STEP7 Set PROFIBUS DP

The following shows how to use STEP7 to configure GT200-DP-EI:

First of all, copy *. gsd file to the following path: Step7\S7data\gsd\

1. Open SIMATIC Manager . Figure 1:

Figure 1

2. Click File->New, create a new project. Figure 2:

Figure 2
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3. Insert->Station->SIMATIC 300 Station. Figure3:

Figure 3

4. Open S7 PLC hardware configuration: SIMATIC 300(1)->Hardware, double-click. Figure 4:

Figure 4
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5．Click Option->Update Catalog, update GSD in device catalog.

Figure 5

6. Here you can find your equipment in the right side of the window. Figure 6
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Figure 6

7. Set PLC rack, click the "Hardware Catalog \ SIMATIC 300 \ RACK-300 \ Rail". Figure 7:
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Figure 7

8. Set CPU module and select the corresponding device type and the occupied slots.

9. Create PROFIBUS DP network and set up PROFIBUS DP: Click New and then Network settings, select DP.

select a baud rate such as 187.5Kbps, then "OK". Double-click it. Figure 8:
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Figure 8

10. Select PROFIBUS Master station address, Figure 9:

Figure 9

Select PROFIBUSAddress
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11. Drag GT200-DP-EI to PROFIBUS DP network bus, and drag data modules to a slot, that is mapping the input

and output data module into master controller's memory. Figure 10:

Figure 10

Operation is divided into two steps, the first step is dragging GT200-DP-EI to PROFIBUS DP network bus, the

mouse will change shape, and that is to say, it can be placed. The second step is dragging data module into master

controller's memory.

Note: The slave address should be the same as rotary switch of module!

12. Compile and download into PLC.

Drag the data to the left

bottom of the table.


	Important Information
	Warning
	Copyright
	Trademark
	Technical Support Contact Information
	1.1 Function
	1.2 Features
	1.3 Technical Specification
	1.4 Related Products
	1.5 Revision History

	2 Hardware Description
	2.1 Product Appearance
	2.2 Indicators
	2.3 Switch
	2.3.1 DIP Switch
	2.3.2 PROFIBUS DP Address Setting Switch

	2.4 Interface
	2.4.1 Power Interface
	2.4.2 Ethernet Interface
	2.4.3 PROFIBUS DP Interface


	3 Installation
	3.1 Machine Dimension
	3.2 Installation Method

	4 Quick Start Guide
	5 Configuration Software SST-EP-CFG 
	6 Working Principle
	6.1 EtherNet/IP Connection Parameters
	6.2 How to Read/Write I/O Data
	6.2.1 Read and Write Data using I/O mode(Recommend
	6.2.2 Read and Write Data using MSG

	6.3 Step7 Read and Write Gateway Data 
	6.4 Network Status Monitoring

	7 Typical Application
	Appendix: Using STEP7 Set PROFIBUS DP

